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Creating Files for Use in Preps

If you plan to submit a QuarkXPress 6.5 document for imposition in Preps, you
must save it as either a PostScript file or a single-page EPS (encapsulated PostScript)
file. This document describes how to create PostScript files from QuarkXPress 6.5
documents on the Microsoft Windows operating system.

PostScript files that you produce can include composite or pre-separated color,
depending on the structure of the QuarkXPress document. For multiple-page
documents, we recommend that you create color composite files whenever
possible. However, if you want to retain QuarkXPress trapping information, you
must create a pre-separated file. Preps cannot preview individual color plates for
pre-separated QuarkXPress PostScript files.

EPS files are device independent, so there is no page-size limit, which is important
for larger page sizes. EPS files saved from QuarkXPress pages that contain bleeds
require offsets in Preps to correctly position the page information.

Note: A better way to create PostScript or EPS files for use in Preps is by using the Preps
& PXT 4.5.x extension. The PXT extension and user guide are available from the Preps page
on http://graphics.kodak.com/.

Document Features Supported

Documents created in QuarkXPress that are to be imposed in Preps can include
color TIFF images, traps, bleeds, and OPI image links.

Colors

When you print a document to a PostScript file, if the QuarkXPress document
contains embedded color TIFF images, you must select a color output device to
retain the color information in the PostScript file. If you select an output device that
does not support color, QuarkXPress converts the TIFF images to grayscale. We
recommend using the ScenicSoft Color device (ssicolor.ppd).

The color options for QuarkXPress 6.5 are:

* Composite CMYK: Converts TIFF images to CMYK

* Composite RGB: Converts TIFF images to RGB

* Asls: Leaves images in the color space in which they were originally defined

* DeviceN: Represents images with DeviceN colors where appropriate. This is the
most appropriate setting when you print documents that include spot colors.
Images are retained in their original color spaces.
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Traps

Bleeds

To retain QuarkXPress trapping information, you must create a pre-separated
PostScript file.

Bleeds are supported in “print to file” PostScript files. If you create EPS files from
QuarkXPress pages (Save Page as EPS), you must use offsets in Preps to correctly
position the page information.

OPI Links and DCS

If you embed (include) or link (omit) TIFF or EPS images, you can use any of the
methods to create PostScript files. If you embed DCS images, you must create pre-
separated PostScript files.

If you omit images, you must use Preps XL, Preps Pro, or an OPI server to merge in
the high-resolution image data.

Creating a PostScript File

To create a PostScript file, you need to set up a generic virtual printer, prepare a
PostScript file to hold the document’s information, set various document options,
and then print all this information to the PostScript file.

Set Up a Virtual Printer

To create consistent, good PostScript files from QuarkXPress, you use the “print to
file” method, which prints your documents to a virtual printer. For this, we
recommend that you set up a generic color device called ScenicSoft Color. To create
a suitable printer driver, you apply the ssicolor.ppd printer software, which is on the
Preps CD. You must also add ssicolor.ppd to QuarkXPress.

Add and Configure a ScenicSoft Virtual Printer

Before you can create PostScript files by printing documents to “file”, you must set
up an Adobe or Microsoft printer driver specifically for printing to file.

For instructions, see “Using Adobe and Microsoft Drivers on Windows 2000” or
“Using Adobe and Microsoft Drivers on Windows XP”, available from the Preps CD
or the Preps Documentation page at http://graphics.kodak.com/.
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Add ssicolor.ppd to QuarkXPress

1.

In QuarkXPress, from the Utilities menu, choose PPD Manager.

Include | Mame [
+ Apple Lazerariter Plus v42.2 -
+ defaults. ppd
+ Fiery ) DocuColor 40 Color Server w2017.103
+ Fiery 2 DocuColor 70 Color Server Verl.0
v ScenicSoft Color
¥ Scitex SXDC40Pr hd

Location:

—¥ Use Ausiliary Folder

Falder: IE:\F'reps 5 0%Printersippd

Update | ok |

Cancel

Select the Use Auxiliary Folder check box.
Click Select.

On the Preps CD, locate the \Preps Extras\ScenicSoft Color PPD folder, and
then the appropriate sub-folder for your operating system. (If Preps is installed
on your computer, you can find the file at \Preps X\Printers\ppd\.)

Select ssicolor.ppd and click Open.
Click OK.

Set Up And Print a PostScript File

To create (“print”) a PostScript file from a QuarkXPress 6.5 document, you must

configure several printing options.

Note: Any settings not mentioned here are optional.

General Options

1.

With the QuarkXPress document open, from the File menu, choose Print.

Print Layout 1 E

Printer: I ScenicSoft Color [FILE]

j Froperties... |

Frint Style: IDefauIt j
Copies: I‘I Pages: IAII j
Layout | Setup I Dutputl Dptionsl Layersl Bleed I arl I Previewl

™ Separations ™ Spreads I~ | Collate

[V Prirt Blank Pages ™ Thumbnails [" Back to Front

FPage Sequence: |A|| vl

Fiegistration: lm Offzet: IF

Tiling: lﬁ [Hwerlap: l— I™ | &bsalute Dyverlap
’TI Cancel | Capture Settings |

From the Printer list, select a printer that you configured to use ssicolor.ppd.
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3. In the Copies box, type 1.

4. From the Pages list, select All.

Layout Tab

1. In the Print dialog box, click the Layout tab.
Printer. [ ScenicSoft Color [FILE) | Propeities... |
Frint Style: IDefauIt j
Copies: I‘I Pages: IAII j

Layout | Setup I Dutputl Dptionsl Layersl Bleed I oFl I Previewl

™ Separations ™ Spreads I~ | Collate
[V Prirt Blank Pages ™ Thumbnails [" Back to Front
FPage Sequence: |A|| vl

Fiegistration: IEentered 'l Offzet: |12 pt
Tiling: Ifo 'l [Hwerlap: I I™ | &bsalute Dyverlap

Frint I Cancel | Capture Settings

2. Set the Separations check box as required:

* Select to create a pre-separated PostScript file.
* Clear to create a composite PostScript file.
3. Select the Print Blank Pages check box.

4. Clear the Spreads, Thumbnails, Collate (if it is available), and Back to Front
check boxes.

5. From the Registration list, select Centered.

6. In the Offset box, type the distance you want the crop marks to be offset from
the edge of the page. We recommend 12 points.

7. From the Tiling list, select Off.

8. Leave the Overlap box blank.
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Setup Tab

1. In the Print dialog box, click the Setup tab.
Printer. [ ScenicSoft Color [FILE) x| Propeties. |
Frint Style: IDefauIt j
Capies: I‘I Pages: IAII j

© N o U

10.
11.

Layout Setup |Dutput| Dptionsl Layersl Bleed I arl I Previewl

Frinter Description: I ScenicSoft Colar j
Faper Size: I Custom j
Faper ‘Width: |95“— Faper Offset: IU“—
Faper Height: lm FPage Gap: IU“—

Fieduce or Enlarge: I"UT/° [ Fitin Print &rea
Page Positioning: ILeftEdge 'l Orientation: ™ Portrait

" Landscape

Frint I Cancel | EaptureSettingsl

From the Printer Description list, select ScenicSoft Color—see “Add and
Configure a ScenicSoft Virtual Printer” on page 2.

If the device is correctly configured, the following options are available.
From the Paper Size list, select Custom.

In the Paper Width box, type a number that is 1 inch wider than the width of
the document.

In the Paper Offset box, type 0.

From the Paper Height list, select Automatic.
In the Page Gap box, type 0.

In the Reduce or Enlarge box, type 100%.
Clear the Fit in Print Area check box.

From the Page Positioning list, select Left Edge.

For Orientation, click the Portrait icon, even if the document is landscape
orientation. This ensures that the page is not rotated improperly
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Output Tab

1. Click the Output tab.
Printer. [ ScenicSoft Color [FILE) x| Propeiies.. |
Frint Style: IDefauIt j
LCopies: I‘I Pages: IAII j

Layoutl Setup  Output | Dptionsl Layersl Eleed I OFl I Previewl

Fring Colors: IDeviceN 'l Besalution: |24DD vl[l:lpi]
Halftoning: IEonventionaI 'l Frequency: |150 | [Ipi]

Frint_~] Plate |Halftone = | Frequency ~|&ngle | Function ~|
+ Process Cyan - 150 105* Drefault -~
+ Process Magenta - 150 e Drefault
¥ Process Yellow - 180 90° Default
¥ Process Black - 180 45" Default
¥ PANTOME Orange 0. K K K K LI

Frint I Cancel Capture Settings |

2. From the Print Colors list, select:

* DeviceN for non CMYK color-space documents

* Used Process & Spot for color-separated documents
3. From the Halftoning list, select Conventional.

4. The recommended dpi for the selected output device appears in the
Resolution list. If your print vendor requires a different resolution, select it
from this list.

5. In the Frequency box, type the line screen specified by your print vendor.

Options Tab

1. Click the Options tab.
Printer. [ ScenicSoft Color [FILE) x| Propeiies.. |
Frint Style: IDefauIt j
Capies: I‘I Pages: IAII j

Layoutl Setup I Output  Options | Layersl Bleed I arl I Previewl

™ Quark PostScript Error Handler

Page Flip: INone 'l ™ Megative Frint
Picture:
Output: INormaI 'l I~ Full Bies of Fiotated Dhjgcts
Data: IBinary vl I Overprint EPS Black
I Ilnclude Images 'l ¥ Full Resolution TIFF Output

Frint I Cancel | EaptureSettingsl

Clear the Quark PostScript Error Handler check box.
From the Page Flip list, select None.

Clear the Negative Print check box.

A

In the Pictures area, from the Output list, select Normal.
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6. From the Data list, select the data format option specified by your print
vendor.

7. Clear the Full Res of Rotated Objects check box (if it is available).
8. Select or clear the Overprint EPS Black check box as required.
9. Select the Full Resolution TIFF Output check box.

Layers Tab

1. Click the Layers tab.
Printer. [ ScenicSoft Color [FILE) x| Propeiies.. |
Frint Style: IDefauIt j
LCopies: I‘I Pages: IAII j

Layoutl Setup I Dutputl Options  Layers | Bleed I arl I Previewl

Frint vI "o | Mame [ I
v W Laver2 =
v W Laperi
v Default

Flates uzed on Selected Layer [ Apply to Layout

Mo selection ;I

Frint I Cancel | EaptureSettingsl

2. Ifthere are layers in the document, set them to print or not print as required.

3. Select or clear the Apply to Layout check box as required.

Bleed Tab

1. Click the Bleed tab.
Printer: IScenicSDFt Color [FILE] j ﬂl
Frint Style: IDefauIt j
LCopies: I‘I Pages: IAII j

Layoutl Setup I Dutputl Dptionsl Layers Bleed |DF'I I Previewl

Bleed Type: ISymmetric 'l Amount; ID.‘I25"

[¥ Clp at Bleed Edge Bottorr [0
Left: ID"
Right: 0"

Frint I Cancel | Capture Settings

2. From the Bleed Type list, select Symmetric.
3. Select the Clip at Bleed Edge check box.

4. In the Amount box, type the amount of bleed you want.



Creating Files for Preps From QuarkXPress 6.5 for Windows

Optional: OPI Tab
Set up the OPI tab as needed (not required for Preps).

Optional: Preview Tab

The Preview tab displays a summary of the settings you selected as well as a
graphical representation of how the document pages fit on the selected page size.

Print the setup information to the PostScript file

After following the previous steps, you are ready to finish printing the QuarkXPress
document information to a PostSript file. Click Print on any of the options tabs.

You can now add this file to a Preps job.

Creating an EPS File

(5

Important: This section describes one possible method; however, it does not include
fonts in the EPS files produced. For better results, use a Preps PXT 4.5 extension. Preps
PXT offers several options for exporting QuarkPress 6.5 document pages in EPS format.
PXT and its user guide are available on the Preps page on http:/graphics.kodak.com/ .

Save the Page as an EPS File

Note: Any settings not mentioned here are optional.

1. From the File menu, select Save Page as EPS.

Save Page as EPS ﬂ E
Savein | (d Saved EPS Files =] « @k E-
File marne: IPage 1 e I

Save as type: |EPS File [*.2ps] | Cancel |

Save Page az EPS |Bleed | arl I

Page: I‘I Format: I Colaor - l
Scale: I"UT/° Space: IDevice M 'l
Preview: ITIFF 'l

[™ Spread Data: IBinary VI
V' Transparent Page (] Ilncludelmages 'l
Size: 85" = 11"

2. Select from the Save In list or locate the folder where you want to save the file
3. In the File name box, type a name for the file.

4. From the Save as type list, select EPS File (*.eps).
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Set Up the EPS Options

1.

Click the Save page as EPS tab.

2. In the Page box, type the number of the document page that you want to save
as an EPS.
3. In the Scale box, type 100%.
4. Clear the Spread check box unless you want facing pages to be saved as a single
page.
5. Select the Transparent Page check box.
6. In the Format box, select Color.
7. From the Space list, select CMYK if the document does not contain spot colors,
or select DeviceN if the document does contain spot colors.
8. From the Preview list, select None.
9. From the Data list, select the data format option specified by your print
vendor.
10. If the OPI list is available, select the graphic option specified by your print
vendor.
Bleed Tab
1. Click the Bleed tab.
Save Page as EPS ﬂ E
Save in: | {3 Saved EPS Files R R e o
File name: |Page1 Save I
Save as type: |EPS File [*.2ps] | Cancel |
Save Page as EPS  Bleed | arl I
Bleed Type: ISymmetric 'l Amount; ID.‘I25"
Battarn: ID"
LLeft: ID"
Eighit: ID"
2. From the Bleed Type list, select Symmetric.
3. In the Amount box, type the amount of bleed you want.
4. Set up the OPI tab as needed (not required for Preps).
5. Click Save.

You have created a single-page EPS file from a QuarkXPress document. You can add
the file to a Preps job.
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